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Note the following details of the code protection feature on Microchip devices:
. Microchip products meet the specification contained in their particular Microchip Data Sheet.

. Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the
intended manner and under normal conditions.

. There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our
knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data
Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

. Microchip is willing to work with the customer who is concerned about the integrity of their code.

. Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not
mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our
products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be
superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO
REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR
OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE,
MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Micro-
chip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold
harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or
otherwise, under any Microchip intellectual property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, AnyRate, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KeelLoq, KeeLoq logo,
Kleer, LANCheck, LINK MD, MediaLB, MOST, MOST logo, MPLAB, OptoLyzer, PIC, PICSTART, PIC32 logo, RightTouch, SpyNIC,
SST, SST Logo, SuperFlash and UNI/O are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other
countries.

ClockWorks, The Embedded Control Solutions Company, ETHERSYNCH, Hyper Speed Control, HyperLight Load, IntelliMOS,
mTouch, Precision Edge, and QUIET-WIRE are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Analog-for-the-Digital Age, Any Capacitor, Anyln, AnyOut, BodyCom, chipKIT, chipKIT logo, CodeGuard, dsPICDEM, dsPICDEM.net,
Dynamic Average Matching, DAM, ECAN, EtherGREEN, In-Circuit Serial Programming, ICSP, Inter-Chip Connectivity, JitterBlocker,
KleerNet, KleerNet logo, MiWi, motorBench, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach,
Omniscient Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, PureSilicon, RightTouch logo, REAL ICE, Ripple Blocker, Serial
Quad /0, SQl, SuperSwitcher, SuperSwitcher Il, Total Endurance, TSHARC, USBCheck, VariSense, ViewSpan, WiperLock, Wireless
DNA, and ZENA are trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.
Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestlC is a registered trademarks of Microchip Technology Germany Il GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in
other countries.

All other trademarks mentioned herein are property of their respective companies.
© 2016, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.
ISBN: 978-1-5224-0264-0

Q U AL I TY M A N AG E M E N T SY STE M Microchip received ISO/TS-16949:2009 certification for its worldwide

headquarters, design and wafer fabrication facilities in Chandler and
Tempe, Arizona; Gresham, Oregon and design centers in California

C ERTI F IE D BY DNV and India. The Company’s quality system processes and procedures

are for its PIC® MCUs and dsPIC® DSCs, KEELOQ® code hopping
— devices, Serial EEPROMSs, microperipherals, nonvolatile memory and
_— IS O / TS 1 6 94‘9 — analog products. In addition, Microchip’s quality system for the design

and manufacture of development systems is ISO 9001:2000 certified.

DS50002441A-page 2 © 2016 Microchip Technology Inc.



Object of Declaration: EVB-LAN9252-4PORT

EU Declaration of Conformity

Manufacturer: Microchip Technology Inc.
2355 W. Chandler Blvd.
Chandler, Arizona, 85224-6199
UsAa

This declaration of conformity is issued by the manufacturer.

The development/evaluation tool is designed to be used for research and development in a laboratory
environment. This development/evaluation tool is not a Finished Appliance, nor is it intended for
incorporation into Finished Appliances that are made commercially available as single functional units to
end users under EU EMC Directive 2004/108/EC and as supported by the European Commission’s Guide
for the EMC Directive 2004/108/EC (8" February 2010).

This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU.

This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in
compliance with the essential requirement and other relevant provisions of the R&TTE Directive
1999/5/EC and the FCC rules as stated in the declaration of conformity provided in the module
datasheet and the module product page available at www.microchip.com.

For information regarding the exclusive, limited warranties applicable to Microchip products, please see
Microchip’s standard terms and conditions of sale, which are printed on our sales documentation and
available at www.microchip.com.

Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA

(2-Sep— 1%
Derek Carlson ' Date
VP Development Tools
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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using and
configuring the EVB-LAN9252-4PORT. Items discussed in this chapter include:

* Document Layout

» Conventions Used in this Guide

* The Microchip Web Site

» Development Systems Customer Change Notification Service

» Customer Support

* Document Revision History

DOCUMENT LAYOUT

This document describes how to configure the EVB-LAN9252-4PORT, such as the
DIGIO and SPI, as well as various setup options, scanning, and programming. The
manual layout is as follows:

» Chapter 1. “Overview” — Shows a brief description of the EVB-LAN9252-4PORT
board quick setup.
» Chapter 2. “EVB-LAN9252-4PORT” — Provides instructions in configuring GPIO.

* Appendix A. “Setting Up Master in Windows®” — This appendix shows how to
set up Master in Windows.

* Appendix B. “EEPROM Programming” — This appendix shows how to program

EEPROM.
» Appendix C. “Scanning EtherCAT Slaves” — This appendix shows how to scan
EtherCAT Slaves.

» Appendix D. “Generating SSC Files” — This appendix shows how to change
Vendor ID and Object configuration.

© 2016 Microchip Technology Inc. DS50002441A-page 7



EVB-LAN9252-4PORT Quick Start Guide

CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

| Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris theradixand nis a
digit.

4'p0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl18\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var name [,
var name...]

Represents code supplied by
user

void main (void)

{
}

DS50002441A-page 8

© 2016 Microchip Technology Inc.




Preface

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

» Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip
products. Subscribers will receive e-mail notification whenever there are changes,
updates, revisions or errata related to a specified product family or development tool of
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

+ Compilers — The latest information on Microchip C compilers, assembilers, linkers
and other language tools. These include all MPLAB C compilers; all MPLAB
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK
object linker); and all MPLAB librarians (including MPLIB object librarian).

+ Emulators — The latest information on Microchip in-circuit emulators.This
includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.

* In-Circuit Debuggers — The latest information on the Microchip in-circuit
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug
express.

* MPLAB IDE - The latest information on Microchip MPLAB IDE, the Windows
Integrated Development Environment for development systems tools. This list is
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and
MPLAB SIM simulator, as well as general editing and debugging features.

* Programmers — The latest information on Microchip programmers. These include
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included
are nonproduction development programmers such as PICSTART Plus and
PIC-kit 2 and 3.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:
+ Distributor or Representative

* Local Sales Office

+ Field Application Engineer (FAE)

 Technical Support

© 2016 Microchip Technology Inc. DS50002441A-page 9
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Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at:
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revisions Section/Figure/Entry Correction

50002441A (02-03-16) Initial release of document
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Chapter 1. Overview

1.1 INTRODUCTION

This document describes how to use the EVB-LAN9252-4PORT Software develop-
ment kit as a development tool for the Microchip EVB-LAN9252 EtherCAT® Slave Con-
troller.

Note: All the figures in the document are captured from TwinCAT 3.1. I

111 Abbreviations

IDE - Integrated Development Environment
ESC - EtherCAT Slave Controller

EVB - Evaluation Board

HAL - Hardware Abstraction Layer

HBI - Host Bus Interface

SPI - Serial Protocol Interface

SSC - Slave Stack Code

© 2016 Microchip Technology Inc. DS50002441A-page 11
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Chapter 2. EVB-LAN9252-4PORT

21 MASTER CONFIGURATION

The following steps describe how to configure EtherCAT Master and Slave:
1. Configure the EtherCAT Master with the TwinCAT® driver.

Note: Refer to Appendix A. “Setting Up Master in Windows®” for Windows®
configuration.

2. Download and extract EVB-LAN9252-4PORT_PIC32 SDK Vx.x.zip from
the Microchip website (http://www.microchip.com/LAN9252-041715a).

Note: x.xx denotes the version number of the SDK. I

3. InSDK, the \ESI Files directory contains the ESI files which can be loaded to
EVB-LAN9252-4PORT EEPROM using TwinCAT, as displayed in Figure 2-1.

FIGURE 2-1: ESI FILES DIRECTORY
=] Microchip EVB-LANS252-4P0ORT xml

Note: Refer to Appendix D. “Generating SSC Files” to change the Vendor ID
and slave information in ESI files.

4. CopyMicrochip EVB-LAN9252-4PORT.xml to the directory path C:\Twin-
CAT\3.1\Config\Io\EtherCAT for TwWinCAT 3.1.

5. Configure the EVB as mentioned in “Configuration Section 2.4” of
EVB-LAN9252-4PORT EtherCAT® ESC PHY Connection Mode User’s Guide
from the Microchip website (http://www.microchip.com/DevelopmentTools/Pro-
ductDetails.aspx?PartNO=evb-lan9252-4port).

6. By default, corresponding ESI file of PIC32 firmware is flashed to the delivered
EVB-LAN9252-4PORT (Board1 and Board2). To change the firmware in PIC32
SoC for Board1 and Board2, refer to Appendix D. “Generating SSC Files” and
Appendix E. “Compiling and Programming SoC Firmware”.

Note 1: The pre-built binaries are available in the “Binaries” directory. This step
can be skipped if pre-built binary is used for programming.

2: SoC firmware must be changed for both Board1 and Board2 in case of
firmware re-programming.

7. Launch TwinCAT and scan EtherCAT slaves from TwinCAT. Refer to Appendix
C. “Scanning EtherCAT Slaves” to scan the slaves.

8. Program EEPROM using Microchip EVB-LAN9252-4PORT.xml. Refer to
Appendix B. “EEPROM Programming” for EEPROM programming instruc-
tions. If the EEPROM is programmed successfully, the device state will enter into
‘OP’ as displayed in Figure 2-2.

Note: EEPROM ESI file must be programmed for both Board1 and Board2. I

© 2016 Microchip Technology Inc. DS50002441A-page 13
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FIGURE 2-2: OP MODE

TwinCAT Projectl2 R > BNl R =7l

| General | EtherCAT | Process Data | Online |

State Machine
[ Init ] [ Bootstrap ]
Cument State: oF
| PreOp | [ 5afeOp |
Fequested State: QF
[Op ] [ Clear Emor ]
DLL Status
Port A: Camier / Open
Port B: Mo Camier / Closed

Mo Camier # Closed

Mo Camier # Closed

File Access over BtherdZAT
Download... Upload...

22 DEMO

The following describes a demo of the EVB-LAN9252-4PORT:

1. Follow the steps as mentioned in Section 2.1 “Master Configuration”. Two
demo objects can be seen on the Solution Explorer of TwinCAT, as displayed in
Figure 2-3.

FIGURE 2-3: GPIO INPUTS AND OUTPUTS
4 o

4 "L Devices

4 [ Device 2 (EtherCAT)

*B Image

*E Image-Info
2 SyncUnits
Inputs
B Outputs
& InfoData
&% Box 1 (PIC32 EtherCAT Slave)

F Inputs
# GPIO INPUTS

[ - -

4 [ Qutputs
- GPIO_QUTPUTS
[ [ WeState

= [ InfoData
ﬁ:l Mappings

2. As part of this demo, two object variables GPIO_INPUTS and GPIO_OUTPUTS
are mapped to PIC32 GPIOs as mentioned below.

DS50002441A-page 14 © 2016 Microchip Technology Inc.
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GPIO_OUTPUTS - PIC32 RD2
GPIO_INPUTS - PIC32 RD3

3. Interconnect RD2 and RD3 hardware pins for demo purpose, as in Figure 2-5.

FIGURE 2-4:

Q

0
o]
o]
(o}
10
‘O
o]
o

o
o
o
o

0,

N
LJ

RD2 AND RD3

0000000000000000850008kH60

4. To change GPIO_OUTPUTS, double-click the GPIO_OUTPUTS option under
Outputs in the Solution Explorer, as displayed in Figure 2-3.

The TwinCAT project window displays.

5. Click the Online tab in TwinCAT project window and select the Write option to
change GPIO outputs, as displayed in Figure 2-5.

FIGURE 2-5: GPIO OUTPUTS
Variable | Flags | Online
Value: 1 ( Set Value Dialog l&]‘
New Value: Force... Release White....
- = = Dec: 1]
Comment: Hex: 001

Float:

Binary: o
Bit Size: @1 ©8 @158 O Ot @7

6. Toview GPIO_INPUTS, double-click GPIO_INPUTS under Inputs in the Solution
Explorer, as displayed in Figure 2-3

7. Click the Online tab in the TwinCAT explorer window as displayed Figure 2-6.

© 2016 Microchip Technology Inc.
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FIGURE 2-6:

GPIO INPUTS

TwinCAT Project2l

Oniine

Value:

MNew Value:

Comment:

1

rce

Write..
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Appendix A. Setting Up Master in Windows®

A.1  INTRODUCTION
®

This appendix shows how to set up Master in Windows™.
Download and install TwinCAT on Windows from http://beckhoff.com.

A1.1 TwinCAT Ethernet Driver - Installation

To install the TwinCAT Ethernet Driver, do the following:

1. If TwinCAT installed successfully, a TwinCAT icon will display in the bottom-right corner of the desk-
top. Click the TwinCAT icon.

A pop-up menu displays.
2. Select TWINCAT XAE (VS XXXX), as displayed in Figure A-1.

Note: VS XXXX refers to the version of Visual Studio installed on the computer. I

FIGURE A-1: SYSTEM MANAGER

¢ About TwinCAT...

|u:| TwinCAT XAE (VS 2013)

Tools ]
Router »
Systern k

L&l Ll Iy 12/16/2015
3. Go to TWINCAT>Show Real Time Ethernet Compatible Devices... as in Figure A-2.

© 2016 Microchip Technology Inc. DS50002441A-page 17
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FIGURE A-2: SHOW REAL TIME ETHERNET COMPATIBLE DEVICES
w TwinCAT Projectl] - Microsoft Visual Studio
FILE EDIT VIEW PROJECT BUILD DEBUG | TWINCAT | PLC TEAM  TOOLS TEST SCOPE  AMNALYS

SO o2 % |
Vﬁ“ﬂ# @|61cf“"| <Local>

o
»
4

Activate Configuration

Restart TwinCAT System

Restart TwinCAT (Config Mode)

Y -l

Reload Devices
Scan

Teggle Free Run State
Show Online Data

Show Sub Items

Security Management...

Access Bus Coupler/IP Link Register...
Update Firmware/EEPROM

Show Realtime Ethernet Compatible Devices...
EtherCAT Devices

About TwinCAT

4. Select the Network adapter and install the TwinCAT driver as in Figure A-3.

FIGURE A-3: ETHERNET ADAPTERS DIALOG
Installation of TwinCAT RT-Ethermnet Adapters &
Ethemet Adapters Updaste List
E¥ Inctabed and ready to use devices
[l &F Compalible devices Instal

ol Local Area Connection - Intel[R) Ethernet Connection (3] 1218

|

|

=¥ Incompalible devices |
i"‘ wlireless Metwork Connection - 242 11b/g/n 'Wireless LAM M.2 Adapter |
|

|

¥ Dzabled devices Erabi
nable

Disable

[ Show Bindings:

—_— ]

5. Once the TwinCAT driver is installed successfully, the driver is compatible with the TwinCAT master.
The network adapter will then be moved to “Installed and ready to use devices” as displayed in

DS50002441A-page 18 © 2016 Microchip Technology Inc.
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Figure A-4.

FIGURE A-4: INSTALLED AND READY TO USE DEVICES

Installation of TwinCAT RT- | —

Ethernet Adapters |dpdate Lizt

- l‘-'." Inztalled and ready to uze devices(realtime capable]
P l_-'." Local Area Connection - TwinCAT -Intel PCl Ethernet &dapter [Gigabit]
Inztalled and ready o uze devices(far demo uze only]
: Compatible devices
: l‘-'." Incompatible devices
l_-'." Wirgless Metwork Connection - 242 11b/g/n wWireless LA M. 2 Adapter
LF Digabled devices

(W
&
(W
&

[ Show Bindings

6. Go to the corresponding network adapter properties and then select TwinCAT drivers as displayed in
Figure A-5 and Figure A-6.

FIGURE A-5: NETWORK ADAPTER PROPERTIES MENU
Diagnose this connection Renarne this connection View status
L_' Local Area Connection | L_' Wireless Metworl

- -
== Enabled — e ! e
@~ TwinCAT-Intel PCI Etherny B Disable i
Status
Diagnose

'Ei' Eridge Connections

Create Shortcut
Delete

'5' Rename

'Ei' Properties
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FIGURE A-6:

LOCAL AREA CONNECTION PROPERTIES

U Local Area Connection Properties

™

28]

Networking | Sharing

Connect using:

l‘-'l" TwinCAT-Intel PCI Bthemet Adapter (Gigabit)

This connection uses the following items:

(W 4 Cliert for Microsoft Networks

Il .@GDS Packet Scheduler

Il .@ File and Printer Sharing for Microsoft Networls

<t TwinCAT Ethemet Protocol

[l & Intemet Protocol Version & (TCP/IPvE)

[ -a Intemet Protocol Version 4 (TCP/IPyd)

[ -a Link-Layer Topology Discoveny Mapper 110 Driver
[ -a Link-Layer Topology Discoveny Responder

Description

Allows your computer to access resources on a Microsoft
nietwork.

[ Install... ] [ Uninstall ] Properties

OK || Cancel

e

Note 1: Only select TwinCAT drivers.

2: If TwinCAT cannot find the EtherCAT slaves after following the steps in Appendix
C. “Scanning EtherCAT Slaves”, restart the computer and attempt to scan again.

DS50002441A-page 20
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Appendix B. EEPROM Programming

B.1 INTRODUCTION
This appendix shows how to program EEPROM.

B.1.1 EEPROM Programming

To program EEPROM:

1. After a successful scan, click the “Device 2 (EtherCAT)” drop-down bar from the Solution Explorer of
the TwinCAT tool, as displayed in Figure B-1.

The TwinCAT Explorer window displays.

FIGURE B-1: DEVICE 2 (ETHERCAT)
Solution Explorer * B X
@0 @ &
Search Solution Explorer (Ctri+;) P

fa] Solution TwinCAT Projectll’ (1 project)
4 o TwinCAT Projectll
b SYSTEM
MOTION
PLC
3 SAFETY
C++
4 [F10

4 " Devices
4 [ Device 2 (EtherCAT)

*B Image

*B Image-Info
2 SyncUnits
Inputs
B Outputs
[F InfoData
BER Box1 (LAM9Z52-DIGIO-2PORT)
ﬁ" Mappings

R A A~ 4

2. Click the Online tab in the TwinCAT project window.

3. Right-click the LAN9252 listing and select “EEPROM Update” from the contextual menu, as displayed
in Figure B-2.
The Write EEPROM window displays.

© 2016 Microchip Technology Inc. DS50002441A-page 21
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FIGURE B-2: ONLINE TAB

| General | Adapter | EtherCAT | Online | CoE - Online |

Mo Addr  MName State CRC

1001 Box 1 (LANS252-DIGIO-2PORT) -
Request TNIT' state

Request '‘PRECP" state
Request 'SAFEQP' state
Request 'OP' state

Request '‘BOOTSTRAP' state

Clear 'ERROR' state

EEPROM Update...

Firrnware Update...

Advanced Settings...

Properties...

Export...

4. Select the corresponding EEPROM configuration and then click OK to initiate EEPROM program-
ming.

For example, Figure B-3 shows LAN9252 one of DIGIO configuration is selected for EEPROM pro-
gramming in the TwinCAT.
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FIGURE B-3: WRITE EEPROM DIALOG
Write EEPROM =5
Available EEPROM Descriphions: [7] Show Hidden Devices oK

[ Beckhoff Automation GmbH & Co. KG
EI. Microchip Technology [no
[ Micrachip PIC32 Slaves

=88 LANS252D1GI0
- -]59252 5 Ch. Dig. In-/Dutput 24MI11 [Na DC] (13 /1]

Browse. ..
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Appendix C. Scanning EtherCAT Slaves

C.1  INTRODUCTION

This appendix shows how to scan EtherCAT Slaves.

CcC11 Scanning EtherCAT Slaves

To scan EtherCAT slaves:
1. Connect Port 0 of the device to master using RJ45 Ethernet cable, and then power up the board.

The Link/Act LED should be ON at Port 0 when the cable is present. If the Link/Act LED is not ON, it
indicates there is an issue with the connection or cable.

2. If any devices are present, delete them accordingly by clicking the device and selecting Delete
Device, as displayed in Figure C-1.

FIGURE C-1: DELETE DEVICE
PLC
o SAFETY ‘O Add New kem... Ins
I'i; 0 Add Existing Item... Shift+ Alt+ A
4 ¥ Devices 2 Remove Del

4 [ Device 2 (EtherCA Change MNetld...

+H
+ Image Save Device 2 (EtherCAT) As...
*% Image-Info
b2 SyncUnits Append EtherCAT Cmd
P Inputs Append Dynamic Container
> W Outputs Online Reset
B [E InfoData
b B Box1 (LANG252- Online Reload
&’ Mappings Online Delete
¥ Scan
Changeld...
a0 -

3. Right-click “I/O devices” and then select Scan as displayed in Figure C-2.
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FIGURE C-2: SCAN DEVICES MENU

fa] Solution TwinCAT Projectl2' (1 project)
4 o TwinCAT Project12
b @ SYSTEM
MOTION
PLC
| SAFETY

EC++

4 [ 10
*=_ Devices .

&% Mappings| ‘00 Add New ltem... Ins
0  Add Existing Item... Shift+Alt+ A

Export EAP Config File

Scan

Paste Ctrl+V
Paste with Links

4. Click OK to continue scanning as in Figure C-3.

FIGURE C-3: DEVICE DIALOG
1 new [/O devices found ﬁ
[W]Device 2 [EtheiCAT]  [Local Area Connection [TwinCAT-Intel PCI Ethemet A) 0

i

Cancel

| Select Al |
Unzelect Al

b A

If the check box is not checked as displayed in Figure C-4, then either the device is not functional or
driver is not installed properly.
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FIGURE C-4: DEVICE DIALOG, UNCHECKED

1 new I/O devices found

F

[]Dgvice 1 [RT-Ethemet]

[Local Area Connection [Realtek. RTLE163E /281118 Famil] i

Ok,

Cancel

Select All

1y i

nzelect Al

5. Click Yes as displayed in Figure C-5 to scan for boxes.

1S

FIGURE C-5: CONFIRMATION DIALOG

Microsoft Visual Studio

The device list displays as displayed in Figure C-6.

© 2016 Microchip Technology Inc.
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FIGURE C-6: DEVICE LIST

fa] Solution TwinCAT Projectl2' (1 project)
4 o TwinCAT Project12
b @ SYSTEM
MOTION
PLC
153 SAFETY
C++
4 [Fro
4 "% Devices
4 == Device 2 (EtherCAT)
+a Image
* B Image-Info
2 SyncUnits
Inputs
B Outputs
& InfoData
5t Box1 (LAN9252-DIGIO-2PORT)
ﬁj Mappings

[
P
[
>
b

After a successful scan, there will be an activity on Link/Act LED at Port 0.
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Appendix D. Generating SSC Files

D.1 INTRODUCTION

This appendix shows how to generate SSC files.

D.1.1 Generating SSC Files

To generate SSC files:
1. Start the SSC Tool from the start menu, as displayed in Figure D-1.

FIGURE D-1: SSC TOOL

EtherCAT Slave Stack Code Tool

I EEPROM Programrmer

|| EtherCAT Development Documents
B 55C Tool

2. From the menu bar, click File>New as displayed in Figure D-2.

FIGURE D-2: NEW ETHERCAT SLAVE
PIC32 EtherCAT Slave - Slave Stack Code To;I >
File | Project Teool Help
E| 1 Mew  Ctrl+M Slave Settings
[ Open Ctr+0 SSCVerson 5.1
@l Save Ctrl+S Corfig File Version 1.3.3.0
Save Az File: name
o ET—
T ErAppICEteT & pic3?_mchp_gpio_sampls...
. ‘- ProcessData pic32_mchp_gpio_sample...

3. Click Import to import the SSC Tool configuration file Microchip
EVB-LAN9252-4PORT-SSC-CONFIG.xml from the directory {SDK INSTALL -
PATH}/EEVB-LAN9252 SDK VX.X\EVB-LAN9252-4PORT_ PIC32 SDK VX.X/ as displayed in
Figure D-3.
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FIGURE D-3: IMPORT PROJECT

Slave Stack Code Tool | Mew Project @

@ Default

Custom | ELS800 | 2Axis CiA402 Sample

Default SlaveStackCode configuration.
All zettings are available |

Import QK

After selecting the file, click Open to import the SSC Tool configuration file.

4. Once imported, check the “Custom” drop-down box, select “Microchip-EVB-LAN9252-4PORT” con-
figuration, and then click OK, as displayed in Figure D-4.

FIGURE D-4: CUSTOM SSC FILE SELECTED
Slave Stack Code Tool | New Project i @
Default

@ Custom |Micmchip-EUB-LAN5252—4PDHT <Microchip=

i |

Wendor: Microchip (EQ000408).
Wersion: 0.0.1.2

MOTE: This configuration is not provided by Beckhoff Automation and files or file fragments may
be added which are NOT covered by the license from Beckhoff Automation GmbH.

Shall be set if the Slave code executes on an Microchip development board for the PIC32

o

5. All listed parameters under the Slave Information tab can be changed, as displayed in Figure D-5.
Note:

By default, SDK ESI files have an object configuration with Microchip Vendor ID.
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FIGURE D-5: SLAVE SETTINGS
EtherCAT Slave® - Slave Stack : Tool
File  Project Tool Help
Slave Project Navigation Slave Settings
= EtherCAT Slave Mame Value
VENDOR_ID (x4D8
- (Generic ) )
. Hardware VENMDOR_MAME Microchip
... BtherCAT State Machine FRODUCT_CODE (26483062
- Synchronisation REVISION_NUMBER 00000000
=~ Fuppliu:atinn
- ProcessData SERIAL_MUMEER 00000000
- Mailbox DEVICE_PROFILE_TYFE 00001389
- Compiler DEVICE_NAME 55C-Device
DEVICE_HW _VERSION na.
DEVICE_SW_WERSION 511

6. Click Tool>Application>Import from the menu bar, as displayed in Figure D-6.

FIGURE D-6: IMPORT MENU
L
gy PIC32 EtherCAT Slave - Slave Stack Code Tool — -
File  Project | Tool | Help
Slave Project Navigs Show Cenflict Window
Options 11
- Slavelnfom
- (Generic EEFROM Programmer 330
- Hardware Application ¢ | Create new
- BtherCAT Storewesmme g v —— I
- Synchronisation mport
- Application & PIC32 BtherCAT SaveTa..
- ProcessData PIC32 EtherCAT Slave_la...
- Malbax aoeappl ¢ AoE ADS over EtherCA”
- Compiler
aoeapplh

7. Selectthe file pic32 mchp gpio sample app.xlsx which can be found in the directory
{ SDK_INSTALL_PATH} /EVB- LAN9252_SDK_VX . X\EVB—LAN9252—4PORT_PIC3 2_SD—
K VX.X/.

pic32 mchp gpio sample app.xlsxisan object file which contains the information about appli-
cation objects information.

A status message displays as in Figure D-7.
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FIGURE D-7: STATUS MESSAGE

Im port Application | CAEVE-LANS252-PIC32 SDE\pic32_mchp_gpio_sample_app.xlsx @

Application name  pic32_mchp_gpio_sample_app
Logger

Create Excel file parser ...

Parse 'CTAEVE-LANS252-PIC32 SDK pic32_mchp_agpio_sample_app xd=d’ ...

Excel parser | open T:AEVBE-LANGZ52-PIC32 SDK \pic32_mchp_gpio_sample_app xdsx"
Excel Parser | Parse the worksheet "Profile”.

1 Profile Ranges found.

5001.0.0 "Medular Device Profile’ | Columns 2 - 16

BExcel Parser | Parse the column "Modular Device Profile’ (column 2 to 16).

=x=% Modular Device Profile

<< Modular Device Profile

W

Lreate BxBda manning ohiscts
1 FePdo mapping object(s) are created.
Create TxPdo mapping objects.

1 TxPdo mapping object(s) are created.
_heck objects ...

iCZheu:k objects finished.

| Cancel || ok |

8. Click OK to continue.
9. Click the “Project” drop-down menu in the tool bar and then select Create New Slave Files.
The Create new Slave Files window displays, as in Figure D-8.
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FIGURE D-8: CREATE NEW SLAVE FILES
Create new Slave Files @
Project File SPROJECT_FILE_PATH
Source Folder  sspec FILE_PATH/src | Change |
ESI File SES| FILE_PATH [ Change |
Progress

Cancel | | Start

Note: The above values signify the following:

- SPROJECT FILE PATH - The location where the SSC project file is saved.

- $SRC_FILE_ PATH - Default path is SPROJECT FILE PATH. It can be changed by clicking its
corresponding Change button.

- SESI FILE PATH - Default path is SPROJECT FILE PATH. It can be changed by clicking its
corresponding Change button.

10. Click the Start button to create a new project file, Src folder, and ESI file (Slave Information file) in the
desired directory path.

A pop-up window will indicate that the files have been successfully created.
11. Click OK to continue.

Along with generated new slave files, ESI file (.xml file) also will be generated. This ESI file will have
information about new Vendor ID and object configuration. Program this ESI file into EEPROM as
mentioned in Appendix B. “EEPROM Programming”.

12. Replace generated application files with SDK application files as displayed in Figure D-9.
SDK Application files can be found under . /Common directory.
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FIGURE D-9: SDK APPLICATION FILES
Mame Date modified Type Size
€] 9252 HW.c 472272015 3:07 PM C Source 26 KB
nl 2z Hh /2173015 &:45 P /C++ Header KB

<] pic32_mchp_gpio_sample_app.c 6/24,/2015 5:06 PM C Source
] pic32_mchp_gpic_sample_app.h 6/24,/2015 5:06 PM C/C++ Header

] pic32_mchp_gpio_sample_appObjects.h 6,/24,/2015 5:06 PM C/C++ Header

Note: Application files would be named as pic32 mchp gpio sample app asinFigure D-10. This
is because in this demo, input object file is given as pic32 mchp gpio sample app.xlsx
as provided in step 2.

FIGURE D-10: APPLICATION FILES

] ecatslv.h 6,/24/2015 5:06 PM  C/C++ Header 30 KB
] EMMCY.C 6/24/2015 5:06 PM C Source 10 KB
h] emcy.h 6,/24/2015 5:06 PM  C/C++ Header SKE
<] eceappl.c 6/24/2015 5:06 PM C Source 11 KB
h] eceappl.h 6,/24/2015 5:06 PM C/C++ Header 10 KB
h| esc. 6/24/ 106 PM JC++ Header

] h 6/24/2015 5:06 PM  C/C++ Head 13 KB
] foeappl.c 6,/24/2015 5:06 PM C Source 11 KB
] foeappl.h 6/24/2015 5:06 PM  C/C++ Header 2 KB
El rnailbox.c 6,24/ 06 P ource

€] mailb 6/24/20155:06 PM  C5 39 KB
| mailbox. 6,24/ 06 Pl /C++ Header

] mailbox.h 6/24/2015 5:06 PM  C/C++ Head 9 KB
tl o fa 6,24/ 06 Pl ource 1

<] objdef 6/24/20155:06 PM  C5 T4 KB
h 1 G 2ds i L I+ f
<] pic32_mchp_gpioc_sample_app.c 6/24/2015 5:06 PM C Source 15 KB
] pic32_mchp_gpic_sample_app.h 6,/24/2015 5:06 PM C/C++ Header 2KB
] pic32_mchp_gpio_sample_appObjects.h 6,/24/2015 5:06 PM C/C++ Header 9 KB

|£ pic32_mchp_spigpic_sample_app.xml G_-'24_-5015 5:06 PM XML Document 2 KB
€| sdoserv.c 6,24/ 106 PM ource &

£] sd 6/24/20155:06 PM  CS5 60 KB
| sdoserv. 6,24/ 06 P /C++ Header

] sd h 6/24/2015 5:06 PM  C/C++ Head 33 KB

13. Browse to the directory where the new files were created, as shown in the example:
- Src (Folder): This folder contains the Beckhoff Slave Stack code.
- Microchip PIC32 Slaves (ESP): Thisisthe SSC Tool project file.

- Microchip PIC32 Slaves (XML): Thisis the EtherCAT slave information file that must be
used as an input to the EtherCAT master tool to configure EtherCAT slave controllers.

14. Copy all the files inside the Src folder to the following directory:
{SDK INSTALL PATH}/EVB-LAN9252-4PORT PIC32 SDK VX.X/SSC/Common

D.1.1.1  WHY REPLACE IS REQUIRED

Generated application files will not have the code for accessing the GPIO lines. GPIO support is provided
in delivered SDK application files. Hence, the replace is required to get the demo application.
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Appendix E. Compiling and Programming SoC Firmware

E.1 INTRODUCTION

This appendix shows how to compile and program SoC firmware.

E11 Compiling and Programming SoC Firmware

To compile and program SoC firmware:
1. Open the MPLAB IDE and import the SSC project.

The MPLAB project file is located under { SDK_INSTALL -
PATH}/EVB-LAN9252-4PORT PIC32 SDK VX.X/SSC/.

2. Compile the source code as displayed in Figure E-1.

FIGURE E-1: SOURCE CODE

'BI.%E.;' |> ,%ﬂ,%mrﬁ |§‘_§' PC: 00

=l | Clean and Build Project (55C) |
1

If the compilation is successful, the output window will display “BUILD SUCCESSFUL” as in
Figure E-2.

FIGURE E-2: BUILD SUCCESSFUL
Search Results | Output - $SC (Clean, Build, ..) % | =)
3 _heap 0x£62 i 0x1000  (403&) &
Total data memory used (bytes): 0x17&2 (5388) 36%
Dynamic Memory Usage
region address maximum length (dec)
heap OxfE2 0x1000 (4038&)
stack Oxl£62 Ox28%e (10338)
Maximum dynamic memory (bytes): Ox38%e (14434)

"C:%\Program Files (x8&)\Microchipixelé&\vwl_ 25\bin"\\xclé-binZhex dist/default/production/PIC24-5PI production.elf —a -omf=elf
make[2]: Leaving directory 'C:/EVB-LRNSZ5Z-PIC3Z SDE/55C/PICZ4-5PI’
make[l]: Leaving directory 'C:/EVB-LRNSZ5Z-PIC3Z SDE/S55C/PICZ4-S5PI’

m

IBU:I_D SUCCESSFUL (total tims: 13s)
Loading code from C:/EVB-LRNSZ5Z-PIC3Z SDE/SSC/PICI4-5PI/dist/default/production/PFICZ4-5PI producticon. hex. ..
Loading completed

4 1 3

3. Before initiating the firmware download, ensure the debugger/programmer is connected to the EVB’s
JTAG pins.

Note: This demo project is debugged with the PICkit-3 In-Circuit debugger/programmer. I

4. To program the PIC32 SoC, click the Make and Program Device Main Project button, as displayed
in Figure E-3.
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FIGURE E-3: MAKE AND PROGRAM DEVICE MAIN PROJECT BUTTON

'%'%'@ |§'_f>" PC: 0x0| |dcn ov z c oab sab IPO

Make and Program Device (Project 55C) i

5. To debug the PIC32 SoC, click the Debug Main Project button, as displayed in Figure E-4.

FIGURE E-4: DEBUG MAIN PROJECT

- - Q}' - ';:,' = PC: 0x0| |dcnoov z c oab sab IPOD =
D RN =

| Debug Project (550) |
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Appendix F. Programming PIC32 Firmware Using Pre-Built
Binaries

F.1  INTRODUCTION

This appendix shows how to program PIC32 firmware.

F.1.1 Programming PIC32 Firmware Using Pre-Built Binaries

Follow these steps to program the PIC32 firmware using pre-built binaries:
1. Download and install MPLAB IPE V X.X from the following link:
http://microchip.wikidot.com/ipe:installation

Note: x.xx denotes the version number of the MPLAB IPE. I

2. Before initiating the firmware download, ensure the debugger/programmer is connected to the EVB'’s
JTAG pins.

3. Open the MPLAB IPE.
The window displays as in Figure F-1.
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FIGURE F-1: MPLAB IPE

[ ity progrmming Evronmment = 10 o=

File View Settings Help

Select Device and Tool Results

Family: All Families -

Checksum: |F7D&3853
Device: PIC32MX795F512L - -. Apply Pass Count: l:l

Toal: Real ICE 5.No : JIT133210349 -

Prc-gram % Erase Read Verify @ Blank Chedk
o ™ feTTTYTT T oY T

Source: |Please dick on browse button to import a hex file

SQTP: |Flease dick on browse button to impaort SQTP file Browse

Output

2015-11-19T17:59: 1240530- Completed loading IPE.

T — T ————————— |
4. Select the corresponding device from the “Device” drop-down box and then click Apply.
Select the debugger/programmer from the “Tool” drop-down box and then click Connect.

6. From “Source,” click the Browse button and select the hex files which can be found in the “Binaries”
directory of EVB-LAN9252-4PORT PIC32 SDK V X.X.

7. Once the hex files are loaded, click Program.

o
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